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1.
Configurations  and Process
1.1.  Desktop Setting ( Browser setting, Security settings, JRE version etc.)
For the Finacle CBS application, the configuration details are specified in the below attached zip file. 





[image: image1.emf]Finacle Desktop  setting version1 1.zip


1.2.  Printer Setting (Passbook)
For the proper printing of the passbook, the Passbook Printer needs to be configured as per the below specified document.



[image: image2.emf]Passbook_printer_s ettings.zip


1.3. ATM Process document and PIN Management
 Please see below the word document for the complete ATM Process and its PIN management.



[image: image3.emf]Creation of  Placeholder  ATM Suspense Account for 4 Sol.doc



[image: image4.emf]Interim process of  handling ATM operations during Pilot.doc


text incomplete in above boxes
1.4. E-Banking Password Printing and PIN Printing
 Please see below the word document for the complete E-Banking password and PIN printing.



[image: image5.emf]Finacle Ebanking  Procedure-PasswordPrinting.docx



[image: image6.emf]Ebanking-pin.pdf


2. 
Common Issues
1.5.  Passbook not printing
1.5.1. Name of the  office or the customer address being printed wrongly in Passbook
Issue Reported : For.e.g It is reported by the counter PA at Srikakulam HO, the name of the PostOffice in the passbook front page is showing as SRIKALAHAS, ANDHRA PRADESH, INDIA, 532001. instead of SRIKAKULAM, ANDHRA PRADESH, INDIA, 532001.
Solution:  Check the city code linked to the address of the Post office or the customer address. Then validate the city code description in the menu HRRCDM. Either the HRRCDM city code in the customer's address / Post office address has to be changed in the address details or the description of the particular code has to be changed in HRRCDM menu.

HRRCDM access is given to DOP Operations team to maintain the details.
1.5.2. Passbook not enabled at the account level 
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Solution: The passbook is not enabled at the account level. The same has to be modified at the account level for passbook printing. 

For PPF account, the menu HACM has to be used for modification of the field A/C statement in the General Details tab. 

For SCSCC accounts, the menus CSCAM/SCSSMAV to be used 

For MIS accounts, the menus CMISAM/MISAMAV to be used
1.6.  Signature related errors
1.6.1. Signature view issues due to desktop settings not proper
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Solution: Please check the desktop settings and then try viewing the signature. 

1.6.2. Signature view issues due to access not provided
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Solution: The issue is present due to the access not provided to the particular user. The changes have to done in the user creation by modifying the USER GROUP NAME to ADMIN  
User to contact the DOP Operations team to get the issue rectified.

1.6.3. Signature/photograph view issue

Error Screen shot
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Solution

Check for the signature view from other user id and other location, preferably DOP Operations Team. Issue may be with the desktop settings. The above issue is not occurring for the below user id as per the screenshot attached.

Solution Screenshot
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1.6.4. Signature view issues - Steps to identify the exact issue

Issue Reported : Signature is not displayed
Solution: The signature not displayed might be due to several factors like

· Desktop Setting not done properly   ]
· Access not given to the user.           ]  Explained in 1.2.1 ,1.2.2 and 1.2.3 above          
· Signature not uploaded properly

If signature is not uploaded in Finacle, system will show the below details:
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· Signature not migrated due to huge size.

Any signatures present in Sanchay Post database which is above 30kb size shall be dropped while migrating in Finacle. After the data upload, as a part of the recon details, Infosys shall provide the details of signatures dropped during upload. POs need to ensure that when the customer whose signtaure is dropped comes to the PO, fresh signature mandate is captured using a new  'account opening form' and customer's transaction is allowed based on the fresh signature mandate. POs to ensure that the account opening form is clearly identified by writing 'Signature mandate' on top of first page of the form . They should also clearly mention the CIF id and account number on the form. The form shall be sent to CPC for scanning and upload of signature in Finacle. 
2.9. Issues in Clearing

2.9.1. Inward clearing issues – Duplicate instrument 
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Solution

In all such cases, the instrument has to be modified or marked as reject in the inward 

clearing process.  Attaching the document with the step by step process. 


[image: image14.emf]Inward Reject.docx


2.9.2. Instrument is post dated 
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Solution
In such cases, the below step by step process has to be followed

1. Invoke HMICZ , select function as 'Revoke Suspension' and enter the zone code
2. In HICTM menu, select modify function and click on Go. 
3. Next screen click on Accept
4. The next screen shows the records which has the post dated instrument date. Modify the record with the proper instrument date and submit

5. Verify through another user 

6. Invoke HMICZ and suspend the zone.
7. Invoke HMICZ and run 'Validation run' and 'Validation report'
8. Invoke HMICZ and Post the zone
9. Invoke HMICZ and close the zone
2.9.3. Instrument type is invalid for scheme 
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Solution

The account 0025387513 belongs to the scheme code SBGEN, hence the issue. The instrument type CHQ is not valid for this scheme code. If the cheque number in invalid then also this error is thrown. The account entered here should belong to the scheme type SBCHQ. 
2.9.4. How to change from SBGEN to SBCHQ if  it is a cheque account and migrated as SBGEN and how to enter available blank cheque numbers?

Transfer the account to SBCHQ using the menu HACXFRSC and issue the cheques via HICHBA menu. 
HACXFRSC Menu Screen shot.

[image: image17]
[image: image18]
2.9.5. Outward Clearing Issue - Sort code not present for a particular bank    and branch combination

Issue Reported : When we lodge the Outward Cheques for clearing the sortcodes related to the concerned cheques ( Nasirabad Bank Branch Codes ) are not being accepted by the software.So How will we enter the Bank Branch related sortcodes without having any Bank code in search option for that particular Branch of Bank. Kindly arrange the all Bank related Codes Or some other solution for feeding.

Solution
Sort code means MICR Code.
1.The cheque can be lodged under the sort code of the 'service branch' of the same bank, if that code is available in Finacle

is it mandatory to select Service Branch Code? Can any other branch code of same bank available in data base be selected?

Answer:  Any valid sort code can be selected.

2.If the sort code of the service branch ( main branch that participates in clearing for that bank ) is not available, then please use the menu HBRTM to add the missing sort code as per the attached document. 
[image: image19.emf]Steps to add the  Sort code in HBRTM.docx


HBRTM manu has not been given to post office. This solution to be executed by DOP CBS Operational Team only.

3. Once the above is done, cheques can be lodged in outward clearing.
2.9.6. Process of handling RBI Circular intimating about a new Bank & Branch: 
Circular from RBI intimating about any new bank shall be received at the local SO/HO. The SO/HO need to forward the said circular to the DOP Operations team which shall  create the new Bank code in the menu option HBKTM and the new branch code in HBRTM. The MICR city code bank code and branch code as entioned in the RBI circular shall need to be input during branch code creation.

In case the Bank is already is in Finacle CBS (by confirming through  Inquiry mode in HBKTM) - a branch code has to be created in HBRTM.

The naming convention of the  bank / branch code is to have the MICR branch code itself.

For DOP CBS Operational Team only.
2.9.7. How to handle Outstation Cheque in Finacle?

Use HIRM menu and follow below mentioned steps:- 

1.
Invoke the menu HIRM.

2.
The details of the cheque and the account number has to be keyed in using the Lodge option.

3.
Finacle will automatically collect the collection charges.

4. 
Verification should be done for the lodged cheque.

5.
Send the cheque physically to the outstation location.

6.
If the cheque is cleared - intimation coming from outstation location - the Realize function needs to be invoked in HIRM menu and submitted.

7.
If the cheque is dishonoured - the dishonour function to be invoked and submitted in HIRM menu option.

2.9.8. What is the procedure for outstation ' AT PAR' cheques. For these kind of cheques no service charge has to be collected)

Solution : The details in charges tab should be deleted in case the charges are not to be collected for 'At Par' cheques.
2.9.9. Carving could not be done due to scheme errors. 

Issue Reported : Error Screen shot
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Solution

Please always click on the Show exception button to get the issue description. 
If the cheque / instrument is not issued/ passed /stopped then this message comes up. Even other errors are also listed related to exceptions like Insufficient available balance , etc. 

In case of such error what is to be done has not been mentioned.
2.10. Transaction posting failure in Inward clearing 
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Solution
There is no write permission for the role id of the user who is trying to post it , hence the issue. In HRPM menu, for the scheme code to which the above account in the screenshot belongs should be given write permission. 

This is for DOP CBS IT Operation Team only as HRPM menu is not available for post office users.
2.10.1. Loan account closure issue

Error Screen shot
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Solution

The above error occurs when the balance is not zero for the loan account. This means that payoff has not been done for the account. Please complete the payoff process and then close the loan account

2.10.2. Premature closure issues

Error Screen shot
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Solution

The above screenshot is not an error actually. It is showing the messages as part of user information during premature account closure. If unsure of the closure proceeds, please do a trial closure, check the report and then proceed with actual closure of the account.
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2.10.2.1. Unprocessed records in outward clearing for this A/c
Issue Reported : While doing SB Account conversion from SBGEN to SBCHQ by using HACXFRSC menu for the SB Account the error showing that "Unprocessed records in outward clearing for this A/c".

[image: image25]
Solution : 
1)Invoke HOCI (Outward Cheques Inquiry ) to know the unprocessed instruments present for the account and get the zone details (Zone code, Zone date).

2)Invoke HOIQ  and give Outward Clearing Zone Code as respective Zone Code and Outward Clearing Zone Set ID as ALL and Outward Clearing Zone Date as respective Zone date and get the Zone sol id from the details.

3)If zone is not regularized, invoke HMCLZOH under the respective zone sol id and regularize and proceed further transferring the account. 

2.11. Cash/Teller account related errors 

2.11.1.  RD loan account payoff done through cash receipt

[image: image26.png]
This error will be thrown in offices migrated in the middle of the month. (ie on or after 2nd) 

In case of Loan Disbursement or Loan Repayment the value date will be automatically changed to 01st of the month as interest is calculated from the 1st of the month for loans. As Cash account of that office will not be available as on 1st (since the office has migrated in the middle of the month) this error is thrown in Supervisor while verification. This error will be thrown only in the month of migration and from 2nd month cash be used for repayment or disbursement.

Workaround to overcome this error

“In case of Loan disbursement – Instead of Cash (even if it is below Rs.20,000) select Transfer and show RD Loan Disburement office account (Account number ending with 323) and pay by cheque or cash from this office account. ( CTM menu is to be used for this )
In case of Loan repayment – Instead of repaying through cash accept loan repayment through Transfer. Transfer can be from RD Loan Repayment office Account (Account number ending with 323) or SB account of customer (if available) (CTM Menu to be used for this).
2.11.2. Transaction not getting posted in CTM/HTM menu
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Solution : 
The user who is trying to do the operation doesn’t have a teller account linked to his employee id, hence the issue. 

Either the teller should be posting the transaction or the user trying to post the transaction should be getting a teller account attached to his employee id. 
2.12. Menu not available to particular user
Issue Reported : When the user tried to invoke any menu, an error is displayed as Menu Not avaialble for the user.
Solution : Please contact DOP Operations Team at Chennai for the required  access to be given to the specified user for the particualr menu id.

2.13. User already logged in and User Account got locked.

Issue Reported : When the user tried to close the browser with out proper logout, again on loggin in, it gives error message as User Already logged in.

Solution : Please contact DOP Operations Team at Chennai for the unlocking the user id.

2.14. User_Menu_ID is undefined
Issue Reported : When the user tried to login and invoke any menu, it gives an error message as User_Menu_ID is undefined.

Temporary Solution :  Logout from Finacle Application. Make Internet Browser as your default browser. Press F-12, Clear all cookies and history. Then try to Logging  through default browser i.e (Internet Explorer)
Mr. sakthivelu Sir to confirm the above changes regarding pressing of F-12.
2.15. EOD Issues

2.15.1. Steps to ensure a fast EOD

Identify all the transactions which are in Entered Status and un-Posted/Partially posted status. 
These Transactions needs to be verified in each post office by using relevant menu at the earliest and before the EOD starts.

If still any transaction is not getting posted then use HTM to post that transaction.

If still transaction is not getting posted, contact FSI Helpdesk immediately.
2.15.2. Steps to Inquire EOD blocking validations. 

· Pending Transactions, Unposted, unverified transactions – HFTI menu should be used.

· Pending inward Zone to be closed -  HIMCZ/HICTM menu should be used.

· Pending Unverified Accounts – HAFI menu should be used

· Pending Unverified Inventory Transaction List – HIMC/HICHB

· HSVALRPT report can be invoked to view the blocking validation for each sol
· For each sol/set the same can be viewed in a custom report in HPR menu. Report Name is EOD – Blocking Validation Report – Under development

2.16. Finacle Not Available or Finacle is Down
2.16.1. Instructions for Users at Post Office

What will be the result of using below instruction is not mentioned.
The below list of instructions is for the users at the Post offices to raise a helpdesk request during CBS-Finacle connectivity issues ( Finacle not accessible)
1) The IncidentReporting.jsp page has to be typed in the browser, the complete path of which can be like http://DOPFSIHELP/.....incidentReporting.jsp  (to be provided once the page is made active)
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2) The below page appears with the details of the user’s computer on the left panel and a section to enter the user details on the right panel. 
The fields which are marked with an asterisk (*) are mandatory.
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3) The city of the user can be chosen from the dropdown provided
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4) On selection of a city, all the pin codes under the city are shown in the Pin Code dropdown
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5) On selection of a pin code, all the post offices under the pin code are shown in the Post Office Name dropdown with the first one selected
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6) On entering all the mandatory fields and a valid 10 digit contact number , the submit button has to be clicked
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7) On successful submission of the page with the user computer details and the user details, the confirmation page appears
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2.16.2. Instructions for L1 Support
Who will use this option and why it is required in FAQ?
The below list of instruction is for the L1 support personnel to view the list of problems logged by the post office users 

1) The CBS_Support.jsp page has to be typed in the browser, the complete path of which can be like http://10.122.97.69:8082/CBS/CBS_Support.jsp. The below page appears with today’s date in yyyy-mm-dd format as default and the list of issues logged
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2) The date range can be changed in yyyy-mm-dd format to view the list of issues for that date range
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2.17. Andheri Connectivity Issue 

Issue Reported : Initially 2 systems are connected with Finacle. Later on when 2 new system are connected, they are not working properly.

Solution : For the newly added two systems, desktop configuration is not done. Once the configuration is completed as per the provided PDF, it started working fine.

2.18. Menu getting locked after repeated use.

Issue Reported : When one menu is continuously used for long time, application is getting locked. User needs to log out and login again.

Solution : Need to analyze.
If solution is not ready, please remove this issue.

2.19. Getting runtime error when user tries to transfer or copy the set number already existing in the outward clearing zone which is not in open status
The user needs to be instructed that any changes that need to be done in clearing zone, the zone status needs to be revoked from previous status (which in this case is suspended ‘S’) to open status ‘O’ and then try to do the required operation.

2.20. MICR zone not closed. All the instruments are not verified.

Issue Reported : All the Instruments are not verified during ZONe closure issue is coming.

Screenshot : 
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Solution:  

1) In HICTM menu verify the instrument. If the instrument is having some error please delete the instrument or mark it as Inward reject in HICTM menu modify mode and then try verifying.
2) In HMICZ, suspend the zone and then do a validation run.

3) After this, post the instrument thru HMICZ menu.

4) If the posting is successful, please close the zone thru HMICZ menu

2.21. The nonsytem or Teller cash accounts are not allowed in this transaction subtype 

Issue Reported : Trying to move the amount from Vault account to teller cash account. Specified error message is displayed.

Screenshot :

[image: image38]
Solution : The User is not marked as Teller. Please modify the user as Teller and then try posting the transaction.

2.22. ECS Set ups to be done

Example for Bangalore GPO

1. HSBM menu to have the SOL 56000100 as Service branch and Member SOL(s) as mentioned in the excel shared by Mr. Gopi. There are different ECS user number for Bangalore alone – but all participate through Bangalore GPO – so only one ECS user number will be populated. The downloaded file can be modified if the ECS user number needs to be corrected.

2. Navigate to menu HSCFM – SOL ID (the Sol ID of the post office participating in ECS clearing example – Bangalore GPO).

a. ECS USER NUMBER    Treasury free text 1 in HSCFM --- 5603181

b. User Bank Account number  Treasury free text 2 in HSCFM.--> 3007000000

c. User defined limit for individual credit items.. MRS Name field in HSCFM  SOL 150000

d. MICR Center , Bank and Branch code – 560 111 002.

2.23. Clearing Report not available.

Issue Reported: All Clearing Transactions should be listed in a single report, no such report is available currently.

Screenshot for the new Report: 
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Solution: New Report named Post Office Clearing Detail Report has been made available in HFINRPT
1. Clearing report can be generated in HFINRPT which will enlist all the clearing transactions for given date.

2. Clearing Transactions for Office accounts will also be listed in the same report.

3. Input Parameters required for the report are: Date, Sol/Set Id and Scheme Code.

[image: image40]
2.8.1. Report output is grouped by Scheme Type, GL Subhead and Sol Id wise. Total and Grand Totals are provided.
3. Formats

1.1.  Issue reporting Format
Before raising the defect or while lodging the defect, the below specified word document needs to be updated by DOP and the same uploaded by the HD team in Meops, so that the issue resolution time is reduced.
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1.2.  Escalation Matrix
PFB the excel sheets for the escalation matrix.
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1. Passbook printer settings for olivetti prs2


Steps for Configuring the Passbook Printer (Olivetti PRS2)


Step 1: Goto Control Panel -> Devices and Printers path.


Step 2: Select Generic IBM Graphics 9pin wide as the Default Printer.
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Step 3: Please select the Printer Server Properties tab on the top as shown in above screenshot. Below screenshot will pop-up.
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Step 4: In Forms tab, please click on Create a new form and in Form name, please type the Name as PassbookNew1.



Please specify the measurements for margins as shown in the below screenshot and click on Save Form and Click on OK button.
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Step 5: In Devices and Printers path, right click on Generic IBM Graphics 9pin wide and select Printing Prefernces. Below specified screenshot will pop-up with Layout and Paper/Quality tabs.
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Step 6: In Layout tab, please click on Advanced button as shown in the below screenshot.
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Step 7: On Click of Advanced button, below specified screenshot will pop-up. Please select the Paper Size as PassbookNew1 and Print Quality as 240*216 dots per inch. Same setting as shown in below screenshot should be done.
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Step 8: In Devices and Printers path, right click on Generic IBM Graphics 9pin wide and select Printer Properties. Below specified screenshot will pop-up with General, Sharing, Devices Setting tabs etc.
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Step 9: Please click on the Devices Settings tab. Below specified screenshot will pop-up.
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Step 10: Please select the Tractor Feed as PassbookNew1 and Manual Paper feed as PassbookNew1 and click on OK button.
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Step 11: After doing the above changes, in General tab, automatically, in the Paper available section, the PassbookNew1 will be displayed as shown in the below screenshot.
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Step 12: In IE browser, please select the Print -> Page set up as shown in the below screenshot.
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Step 13: On click of Page Setup, below specified screenshot will appear. Please modify the settings as shown in the below screenshot.  Please ensure the Page Size is selected as PassbookNew1 and Enable Shrink to Fit option is unchecked.



Also, the Headers and Footers section, all the fields needs to be selected as Empty.
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Step 14: After doing the above changes, a sample passbook may be printed for the first page and the next page for confirmation and verification.
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Interim process of handling ATM operations during Pilot


· It has been decided to launch 4 ATMs at T.Nagar HO(T.N), Chembur HO(Mah), Delhi GPO and IPHO(Delhi) as a Pilot for 1000 ATMs.


· Only POSB ATM/Debit cards can be used in these ATMs.


· ATM/Debit Card requests will be captured in Finacle by the Post Offices and request form alongwith KYC documents will be submitted to their CPC for scanning and uploading as a Change Request Form.


· CPC Bangalore will generate Files on daily basis (detail given in below process for CPC) and upload into YCS Card Management Application.


· PIN will be generated at CPC Bangalore and despatched to the address of the applicant through service registered mail.


· Card Embossing File will be sent by CPC Bangalore to the Card Vendor (presently at Chennai) via e Mail who will deliver Cards after printing at DMCC Chennai.


· DMCC Chennai will prepare Post Office-wise bundles (for personalized cards) and send the same to the concerned Post Offices via service Insured Packet.


· DMCC will send Insta Cards to CPC Bangalore via service Insured Packet.


· CPC Bangalore will create Welcome Kits in Finacle and prepare one envelope containing Welcome Letter, ATM/Debit Card and PIN. Bundles of Welcome Kits will be prepared at CPC and despatched to the concerned Post Offices via service Insured Packets.


· Post Offices concerned will maintain stock and issue registers for personalized cards and Welcome Kits separately in manuscript and take applicant’s signature against delivery in the issue register and make corresponding entries in the stock registers. 


· Maximum balance of Welcome Kits to be retained in a post office will be 125. When stock is reduced to 25, further indent of next 100 Welcome Kits should be sent through YCS application by post office.


· On viewing the indent, CPC Bangalore will generate subsequent Welcome Kits and despatch to the post offices.


· ATM/Debit Card will be issued to Post Office Savings Bank (POSB) Savings Account Holders who have balance of Rs.25000/- at the time of applying ATM/Debit Card. 


· Initially, following services will be available to POSB customers at ATMs:-

· Cash Withdrawal


· Fast Cash


· Balance Inquiry


· Mini Statement 


· Funds Transfer (Funds Transfer within OWN(linked) Savings Accounts) 


· Funds Transfer (Funds Transfer within Savings Accounts of POSB)


· Pin Change 

· Maximum amount that can be withdrawn from ATMs in a single day will be Rs.25000/- and Rs,10,000/- at a time.


· If any existing Account Holder desires to get ATM/Debit Card, application on the prescribed form alongwith KYC documents (if account is opened before migration) is to be obtained.

Process to be followed at 4 HPOs, CPC Bangalore and Bangalore GPO.

· Depositor who wants to have ATM/Debit Card will submit application in the prescribed form at the post office where account stands.

· Counter PA and Supervisor have to see as to whether the account was opened before or after migration to CBS. If account was opened prior to migration, full KYC documents as required as per Master Circular No.1/2012 should be taken.

· Both PA and Supervisor will verify balance in the account and signatures on the application with the information/signatures available in Finacle. They will enter their names and place their signatures at the relevant place in application form.

· PA and Supervisor have to ensure that all fields are properly filled by the depositor. Only literate depositor can apply for ATM/Debit Card.

· ATM Suspense Account has been created for all these 4 post office by DOP IT Team and account numbers are as follows:-

T.Nagar

600017000813


Delhi GPO
110006000814


IPHO

110002000815


Chembur HO 
40071000816

· These ATM Cash A/Cs are locally defined for each & every post office and attached to their Vault Account.

· On the day of cash loading, cash will be handed over to the representative of Vendor i.e NCR and  following financial entry has to be passed in Finacle:-

Use HTM Menu Option


Debit ATM Suspense Account  and Credit Post Office Vault Account  for the amount of cash.

· Postmasters of these 4 HPOs will be provided two ATM Admn. Cards and Keys of ATM as well as ATM Room. Postmaster will handover one ATM Admn. Card to representative if NCR alongwith Cash. A receipt will be taken in the treasurer’s Cash Book. A remittance advice (RA) of the cash should be sent to Bangalore GPO by these 4 post offices as and when cash is handed over to Vendor showing as Cash remitted to Bangalore GPO.

· Bangalore GPO will take that RAs into its account as Cash received from OHO and show as Cash in ATMs in its Cash Book.


· CPC Bangalore will generate report of the transactions happened in ATM on next day by using menu HFTI and putting SWT in the field Channel. Total Amount debited or credited in Savings Account Scheme in all ATMs will be intimated to Bangalore GPO by CPC Bagalore which will enter the amount in Bangalore GPO Cash Book in SB Deposit/Withdrawal through ATMs and net amount will be adjusted against the entry of Cash in ATMs shown in its cash book.

· The following operations will be done in Post Offices via CCMM (Custom Card Maintenance Menu) by Counter PA and Supervisor when the customer (Account Holder) approaches the Post Office and requests for ATM/Debit Cards. DoP will issue Debit Cards. The process is same for personalized and instant cards. Personalized Cards have Card Holder’s name embossed on the card. 


The criteria page and details page of the menu option is provided below.


Criteria Page - CCMM (Custom Card Maintenance Menu)
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· Details Page - CCMM (Custom Card Maintenance Menu)
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The various functions which can be performed in CCMM (Custom Card Maintenance Menu) is explained below


· Add – This option will be used when Account Holder requests for a ATM/Debit Card.


· Criteria Screen - Select A (Add) & Search (or Type) the CIF Number. Press Go


· Details Screen - Click on A(Add) & choose the Account Number for which the card is to be issued


· Details Screen – Select Primary Account Flag = Y . The card will have only one primary account.  


· Details Screen – The choice of card can either be personalized or instant. Personalized cards will bear the Name of the holder & Instant Cards will not bear the name of the holder.


· Details Screen – Select Card Type = P for Personalized Cards, if customer requests for a personalized card.


· Details Screen – Select Card Type = I for Instant Cards & provide the Instant Card KIT Number, if the customer requests an instant card.


· Details Screen – Select “New Card Request” 


· Submit


· Note


· Personalized Cards


· If customer has multiple Saving Accounts & wants to link to same card with all or selective accounts, Post Office should create a request for the Primary Card first.


· When the customer visits the Post Office for collecting the card , Use CCMM(Modify Option) & place a request for activation


· Use CCMM(Modify Option) & link other account to the card.


· Instant Cards


· If customer has multiple Saving Accounts & wants to link to the same card, Post Office should create a request for the Primary Card first.


· Ask the customer to place a request for linking on the subsequent visit , Use CCMM(Modify Option) & link other account to card.


· Modify – This option will be used when Account Holder requests for Linking, Delinking, Activation, Replacement and Hotlisting of Cards. Select M (Modify) & Search (or Type) the CIF Number or Card Number or Both CIF Number & Card Number. Press Go. The details of the cards for the CIF Number or Card Number or combination of Card Number and CIF Number will be displayed


· Linking – This option will be used when the Account Holder requests for linking additional Saving Accounts with the card


· Details Screen – Press A(Add), Select the Account Number which is required to be linked. Select the “Primary Account Flag” as N.  


· Select Action = LNK (Linking) & Press Submit


· Delinking – This option will be used when the Account Holder requests for de-linking Saving Accounts with the card


· Details Screen – Select Action = DLN(De Linking) & Press Submit


· Activation – This option will be used when the Account Holder comes to the post office to collect the card. Activation is only applicable for Personalized Cards

· Details Screen – Select Action = ACT(Activation) & Press Submit


· Hot Listing – This option will be used when the Account Holder requests for hot listing of the card in event of 


· Card is Lost 


· Details Screen – Select Action = “Hot Listing” & Press Submit


· Card is Damaged


· Details Screen – Select Action = “Hot Listing Damaged” & Press Submit


· Card is Stolen


· Details Screen – Select Action =”Hot Listing Stolen” & Press Submit


· Replace


· Details Screen – Select Action = “Hot Listing and Replacing Card & Press Submit


· Replacement – This option will be used when the Account Holder requests for replacement of  the card


· Details Screen – Select Action = Replacement & Press Submit


· ATM Pin Request – This option will be used when the Account Holder requests for subsequent Pin.

· Details Screen – Select Action = “ATM Pin Request” & Press Submit


· Verify – This option will be used to verify the A (Add) or M (Modify) option. The Hot listing of cards in CMS (Card Management System) will be done during the verification in CBS (Finacle) by Supervisor.  Subsequent to Verification, other processing will be done by Bangalore CPC during the End of Day


· Cancel – This option will be used to cancel the A (Add) or M (Modify) Operation conducted by the PA before verification in case of any mistake.


· Inquire – This option will be used to inquire the details in CMS (Card Management System). Either CIF Number or Card Number or Both CIF Number and Card Number can be provided as an input on the criteria page and details will be listed in the “Details Screen”


· History – This option will be used to inquire the request in CBS (Finacle). The enquiry will display the date on which the account holder has requested for the maintenance.

Process to be exclusively followed at Bangalore CPC


· The following operations will be done in Bangalore CPC via CCDM (Custom Card Download Menu). These files are processed automatically by CMS (Card Management System) and details of how to check the errors will be explained in the CMS (Card Management System) User Manuals.


The various extracts which can be downloaded in CCDM (Custom Card Download Menu) is explained below. 


· Branch Registration File – This file contains the details of the SOL ID created in CBS (Finacle) for creating post offices in CMS (Card Management System). This activity is required to be done on the day of migration. CMS (Card Management System) has the details of the supervisor & address of the post offices where the “Welcome Kits” will be dispatched to.


· New Customer Registration File – This file contains all the customers across post offices who have requested for card.


· Account Details File – This file contains requests of all the customers across post offices who have requested for Linking/Delinking of additional accounts to existing cards.


· Address Details File – This file contains the address of all customers who have been issued cards & have made changes to their address.


· Renewal/Re-issue File – This file contains requests of all the customers who have placed a request for Renewal/Re-Issue


· Reconciliation File – This file contains all financial transactions done during the day & is used during the reconciliation of ATM Transactions.
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[bookmark: _Toc331546520][bookmark: _Toc332647210][bookmark: _Toc379187188][bookmark: _Toc379557809]Purpose of the document

This document describes the steps for Password Printing activity after setting the Login/Transaction passwords for any user.



· The password printing will be executed by the batch program.

· The Batch program will be setup on a desktop machine, (dedicated only for password printing) which is connected to the pin mailer printer.

· The batch program can be run by only the users who have access to it.




[bookmark: _Toc331546521][bookmark: _Toc332647211][bookmark: _Toc379187189][bookmark: _Toc379557810]Prerequisites

Following are the pre-requisites required before starting the procedures:

	

1. The Login/Transaction passwords for a user (Retail/Customer/Agent/Super-Agent/RM).

2. FEBA Batch setup. 

3. Login credentials to the Windows to run the batch.

4. Printer connected to the desktop where the batch is run.

5. Connectivity to the e-banking DB where the batch is setup

6. Connectivity to the Core FI where the batch is setup










[bookmark: _Toc379557811]Steps to run the automated PasswordPrintingBatch.bat batch in Windows	



1. Login to the password printing machine and double click on the shortcut to batch file.

[bookmark: _GoBack]Or The PasswordPrintingBatch.bat will be present in the FEBA batch folder.

[image: ]



2. The batch will show the different options available for password printing.

The Bank User has to choose the required option for password printing.
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3. The password will be printed to the pin mailer printer according to the chosen option and the password printing task will be completed.

[image: ]



4. The PDF of the passwords will be present the reports folder



[image: ]

Note: 

· The user should have access to run the batch. That means the username with which the user has logged into the windows machine should have an entry in the CUSR table with UserType=’5’.

· Check that the desktop has connectivity to the e-banking Database.

[bookmark: _Toc379557812]Steps to run the PWDPRINTBATCH in Windows/Unix machine using ScheduleInsertUtility and SchedulerInitializer



We can also run the PWDPRINTBATCH files in manual mode using following files in the FEBA folder. (The machines should have connectivity to the printer)

1. the ScheduleInsertUtility.bat  and SchedulerInitializer.bat in windows machine

2. the ScheduleInsertUtility.sh  and SchedulerInitializer.sh in Unix machine







1. In the FEBA batch folder: Run the ScheduleInsertUtility.



The user will be prompted for the following and should provide appropriate values:



a. Enter the Schedule Name <Shd be Unique in SCDT>* ::

The user has to provide a unique name for the schedule. 

Usually Taskname_date_no is preferred

Ex: PWDPRINTBATCH_7feb_2014_01



b. Enter the Schedule Name <Shd be Unique in SCDT>* ::

For password printing upload: PWDPRINTBATCH



c. Enter the Schedule Task Data <Shd be keyVal pairs separated by ';'> ::

The taskdata change according to the type of user, user’s profile, type of password etc.

The taskdata for different types of users can be checked in the files present in params folder.

Ex: For agents’ login password the task data will be as follows:

NO_OF_RECORDS_PER_CHUNK=10;REPORT_NAME=pwdprint;REPORT_FORMAT=PDF;ACTIVATE_USER=

Y;MENU_PROFILE_LIST_TO_ENABLE=DOPADMIN|DOPADUSR|DOPRMUSR|DOPAGN|DOPSPAGN;USER_TY

PE=B;PWD_USER_ID=*.*;PASSWORD_TYPE=SGNPWD;PRINT_TO_PRINTER=Y;



d. Enter the Schedule Pattern <Format - Sec Min Hrs DayOfMnth Month DayOfWeek [Year]>* ::

Enter : * * * * * * * (Format can be changed as required)



e. Enter the Max Number of Occurrences ::

1 ( the schedule will 1 time)



f. Enter the Holiday Option <Possible Values - YP/YS/YN/NA> : (Blank)

g. Enter the Start Time of Schedule <Format - dd/MM/yyyy HH:mm> :: (Blank)

h. Enter the End Time of Schedule <Format - dd/MM/yyyy HH:mm> :: (Blank)



Once done, the schedule will be inserted successfully.




Following is the screen shot of the ScheduleInsertUtility run in windows machine.
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2. Once the schedule is inserted successfully , run the SchedulerInitializer.
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[bookmark: _Toc379187193][bookmark: _Toc379557813]Appendix: Files with task data for different users and passwords to be printed
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TaskData.zip




RetailSgnOn.txt


PWDPRINTBATCH

NO_OF_RECORDS_PER_CHUNK=10;REPORT_NAME=pwdprint;REPORT_FORMAT=PDF;ACTIVATE_USER=Y;MENU_PROFILE_LIST_TO_ENABLE=RVIEWUSR|RTXNUSER;USER_TYPE=R;PWD_USER_ID=*;PASSWORD_TYPE=SGNPWD;PRINT_TO_PRINTER=Y;

* * * * * * *

1

















RetailTxn.txt


PWDPRINTBATCH

NO_OF_RECORDS_PER_CHUNK=10;REPORT_NAME=pwdprint;REPORT_FORMAT=PDF;ACTIVATE_USER=Y;MENU_PROFILE_LIST_TO_ENABLE=DOPDRG|RUSER;USER_TYPE=R;PWD_USER_ID=*;PASSWORD_TYPE=TXNPWD;PRINT_TO_PRINTER=Y;

* * * * * * *

1

















BankBoth.txt


PWDPRINTBATCH

NO_OF_RECORDS_PER_CHUNK=10;REPORT_NAME=pwdprint;REPORT_FORMAT=PDF;ACTIVATE_USER=Y;MENU_PROFILE_LIST_TO_ENABLE=DOPADMIN|DOPADUSR|DOPRMUSR|DOPAGN|DOPSPAGN;USER_TYPE=B;PWD_USER_ID=*.*;PASSWORD_TYPE=*;PRINT_TO_PRINTER=Y;

* * * * * * *

1

















BankSgnOn.txt


PWDPRINTBATCH

NO_OF_RECORDS_PER_CHUNK=10;REPORT_NAME=pwdprint;REPORT_FORMAT=PDF;ACTIVATE_USER=Y;MENU_PROFILE_LIST_TO_ENABLE=DOPADMIN|DOPADUSR|DOPRMUSR|DOPAGN|DOPSPAGN;USER_TYPE=B;PWD_USER_ID=*.*;PASSWORD_TYPE=SGNPWD;PRINT_TO_PRINTER=Y;

* * * * * * *

1

















BankTxn.txt


PWDPRINTBATCH

NO_OF_RECORDS_PER_CHUNK=10;REPORT_NAME=pwdprint;REPORT_FORMAT=PDF;ACTIVATE_USER=Y;MENU_PROFILE_LIST_TO_ENABLE=DOPADMIN|DOPADUSR|DOPRMUSR|DOPAGN|DOPSPAGN;USER_TYPE=B;PWD_USER_ID=*.*;PASSWORD_TYPE=TXNPWD;PRINT_TO_PRINTER=Y;

* * * * * * *

1

















RetailBoth.txt


PWDPRINTBATCH

NO_OF_RECORDS_PER_CHUNK=10;REPORT_NAME=pwdprint;REPORT_FORMAT=PDF;ACTIVATE_USER=Y;MENU_PROFILE_LIST_TO_ENABLE=DOPDRG|RUSER|DOPRET;USER_TYPE=R;PWD_USER_ID=*;PASSWORD_TYPE=*;PRINT_TO_PRINTER=Y;

* * * * * * *

1
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1. Defect Details 

For all the below specified points, updated comments by HD team is required for the fast issue analysis and quick issue resolution by L2 team.

1.1 Issue Faced in the Branch


<Name of the Sol_ID where the issue occurred>


1.2 Issue faced by the User


<Name of the User ID, by whom the issue is faced>


1.3 Issue Faced in the Menu


<Name of the Menu ID, in which the issue is occurred>


1.4 Issue faced for the entity


<Account Number/CIF Id/Tran ID/Tran Date/Report Name for which the issue is occurred>


1.5 Screenshots


<Attach the required screenshots - the screenshot should be of the same day, same scenario and not the other dates >

1.6 Issue Summary


<Issue Summary in one liner>


1.7 Issue Description


<Issue Description in brief – Complete process followed till the error occurred Stepwise >

1.8 Is the issue faced by one user or all the users in the branch


<Need details as the issue faced by one user or multiple users >


1.9 Is the issues faced in one branch or all the branches


< Need details as the issue faced by one branch or multiple branches >


1.10 Is the issue is the repeated one? Is the solution provided earlier?

<If the issue is a repetitive one, and if the solution for the issue is already shared by L2 Team, issue need not be raised. Same solution can be shared with the client>


1.11 If the issue is the repeated one, please provide the initial analysis by L1

<If the issue is a repetitive one, and if the solution for the issue is not shared by L2 Team, L1 team needs to provide the initial analysis, so that L2 can be made faster in providing the solution.>
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Creation of ATM Suspense Account

1. Check the placeholder in HAPHM,Function = I , Account Placeholder = ATMSUSPENSE, if it exists you don’t have to create the placeholder via HAPHM. The place holder for ATM suspense account should be Cash

2. Check “Type of Cash A/c.” in HSCFM level, SOL Maintenance, the cash account should be modified from Teller to Teller/SYSTEM as ATM suspense Account is not attached to any Teller.

3. Subsequently change context SOL via (HCCS) & create 1 Office A/C per SOL for the post offices where ATM has been installed. 


4. This account should be reviewed on a daily basis by PO(Post Offices)


Creation of ATM Suspense Account and verification - HACMDB
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Steps to add the missing  Sort codes in HBRTM: 

1. Invoke HBRTM and select function as Add. Provide the inputs as the Bank code (for e.g. here 229 is for ICICI Bank) and Bank Type as Inland. Please enter the branch code which needs to be assigned. 

2. Click on Go

[image: ]

3. In the below screen please provide the address details and other mandatory fields as indicated below.



[image: ]



4. Enter the details in the Clearing tab, ie. The MICR Centre code, MICR bank code and MICR branch code as required. For e.g. for ICICI Nasirabad, the MICR Centre code- 305 , MICR Bank code – 229 and MICR branch code is 030. 

5. Click on Submit

[image: ]

6. Verify through another user. 
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1) FINCORE 



1. Introduction 



This document explains the desktop configuration and Internet Explorer settings for Finacle UBS 
Installation 10.2.13. This document explains Internet Explorer (version is IE8.0) Settings for  
Finacle Solutions. 



2. Desktop Setting 



Operating System: Windows 7/Windows XP 
Internet Explorer: Internet Explorer 8.0 



Adobe flash player: Version 10.1.85.3 
Java Version: Sun JRE 1.7.0_17 
Adobe Reader: Version 8.0 



3. Finacle UBS Internet Explorer Settings. 



Please follow the below Internet Explorer settings for Finacle applications. 
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Step Description 



1. Click on Tools 
below figure 1. 



 
Internet Options 



 
Settings and select automatically radio as shown 



Figure 1 



2. Ensure that cache storage size is minimum 250MB. Please refer Figure 1 (step 1) 
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Step Description 



3. Click on the Security tab and select “Local Intranet”. Click on the Default Level 
button as shown below figure 2. 



Figure 2 
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Step Description 



4. Click on the Security tab and select “Trusted Sites”. Add the website 
(https://dpdcnsfswfc1.fsi.indiapost.gov.in) to zone. 



Figure 3 
NOTE: Please add the URLs corresponding to the applications to be accessed. 
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Step Description 



5. Click on the Privacy tab and click the Default Level button. Finacle needs pop-ups 



Facility to be enabled. Our recommendation is to enable Block pop-ups as shown 
in the below figure 4 and add *<bank domain name> to Allowed sites list as 
shown in the below figure 5. 



Figure 4 
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Step Description 



Figure 5 



__________________________________________________________________________________ 



9 of 49 











Finacle Desktop Configuration and IE setting 
__________________________________________________________________________________ 



Step Description 



6. Please set the below Privacy settings. 



Move the slider bar to the very bottom to Accept All Cookies 
(Please refer figure 6) or 



1. Click on Sites. 
2. Type *.<domain name> in the Address of Web site box. Example: 
    bankdomain.com 



3. Click on Allow and make sure you see *.<domain name> with the Always 
   Allow setting in the Managed Web Sites box as shown in figure 7. 
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Step Description 



Figure 7 
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Step Description 



7. Please perform this step only when Proxy server is configured. Click on the 
Connections tab and LAN Settings. If proxy is enabled, then add entry for 
*.<domain name> in “Do not use proxy” box. Please specify the bank URL here 
example *.bankdomain.com. Please refer below figure 8. 



Figure 8 
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Step Description 



8. Click on Advanced tab and select the following settings (if already not selected) 



1. “Use HTTP 1.1” setting under HTTP 1.1 settings (please refer figure 9 below) 
2. “Use JRE xxx” under Java(Sun) (Please refer figure 9) 
3. “Use SSL 2.0” and “Use SSL 3.0” under Security. Please refer figure 10. 



Figure 9 
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Step Description 



9. 



Figure 10 



__________________________________________________________________________________ 



14 of 49 











Finacle Desktop Configuration and IE setting 
__________________________________________________________________________________ 



Step Description 
 



Internet Options 10. Locale settings in browser: Click on Tools 
            en_us as shown below figure 11. 



 
Languages … The default language must be 



Figure 11 
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Step Description 



11. Go to ToolsInternet OptionsSecurityLocal InternetCustom Level 
Miscellaneous Display Mixed Content Disable should be checked as 
shown below figure 12. 



    



Figure 12 
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  Infosys® 



 
 



  



 



 



 
 



Steps Description  



12 Go to ToolsInternet OptionsSecurityLocal InternetCustom Level. 



Downloads->Automatic Prompting for file downloads enabled & File download Enabled as 



shown in figure below: 
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Step Description 



13.   Go to Tools Internet Options Security Local Internet Custom Level 
          Miscellaneous Active X Controls and Plugins “Run ActiveX controls and 
          plug-ins” should be enabled. 



Figure 13 
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Step Description 



14. On The same page “Download signed ActiveX controls” and “Download unsigned 
ActiveX controls” should be enabled. 



Figure 14 
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Step Description 



15. On the same page “Allow Programmatic clipboard access” should be enabled. 
Press OK. 



Figure 15 
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Step Description 



16.  Go to Tools> Internet Options > > Advanced > Browsing> Display notification 
         about every script error – Should be unchecked as shown below figure 16. 



Figure 16 



 Click on Apply and then OK. 
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Step Description 



17. Click on Tools 
 



Compatibility View Settings 
 



Add 
*<bank domain name>.Press close 



Figure 17 
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Steps Description  



18 Click on Tool ->  Internet options ->  
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Steps Description  



19 Click on Tool ->  Internet options -> General -> uncheck browsing history on exit 
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Step Description 



20. Click on View 
 



Encoding and select Unicode (UTF-8) as shown in the below 
Figure 19. 



Figure 19 
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21. 
Click on File 



 
Page Setup and delete contents of Header and Footer. Press OK. 



Figure20 
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22. Ensure Adobe flash player being installed with proper version by visiting 



Tools 
 



Manage Add Ons 



23. Control Panel Program Java Console Advanced Java Plug-in 
Uncheck Enable the next generation java plugin and restart the IE 



     



Figure 22 
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4. Set up specific To Training Desktop. 



After the above setting are done, the application URL has to be saved under Tools Internet 
Options Home Page Link 



The URL is https://dpdcnsfswfc1.fsi.indiapost.gov.in:12005/finbranch/ui/SSOLogin.jsp 



Home Page can be set as the application to be accessed. 



For first time login, Certificate needs to be installed. 



5.Installing Certificate 



1. Click “Continue to this website”. 
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2. Please click on the certificate error 
 



Click View Certificate 
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3 
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4. Click Next 



5. Click Next 
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6. Click Next 



7. If you receive any security warning then click yes.  



8. Click “OK” 
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Finacle e-banking Desktop requirements 



ItemVersion 
Client Side Softwares 
             Windows XP 
ClientSP2/Windo 
Desktopws 
OSVista/Windo 
             ws 7 



Internet 
Explorer 8.0,9.0 



Company 
Mandatory / 
Optional Purpose 



Impacted 
Products Location 



Licensed(L)/Fr 
eeware(F) Com 



Microsoft Mandatory 
OS on end 
user 
desktops 



eBanking Client Desktop L 



Microsoft Optional Browser eBanking Client Desktop F 



Safari 



Firefox 
Chrome 



5 



12,13 
19,20 



Safari 



Mozilla 
Apple 



Optional 



Optional 
Optional 



Browser 



Browser 
Browser 
Java based 
application, 
requires JRE 
to be 
installed 



eBanking 



eBanking 
eBanking 



Client Desktop 



Client Desktop 
Client Desktop 



F 



F 
F 



JRE 1.6 Oracle Mandatory eBanking Client Desktop F 
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6. JAVA Control Panel Settings 



  



  



 
Steps Description  



1 Go to Start .In run type Java Control Panel and Enter. Under Control panel ->Select java 



->Right click -> Select properties -> Security tab->Enable Java content in browser 
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Steps Description  
2 
 



Go to Strart .In run type Java Control Panel and Enter.Under Control panel ->Select java 



->Right click -> Select properties -> Advance tab 
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Steps Description  



3 Go to Strart .In run type Java Control Panel and Enter.Under Control panel ->Select java 



->Right click -> Select properties -> Advance tab 
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Steps Description  
4 Go to Strart .In run type Java Control Panel and Enter.Under Control panel ->Select java 



->Right click -> Select properties -> Advance tab 
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 4. Passbook Printer Settings 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



Steps Description  
1 Go to Start -> Control Panel ->Hardware and Sound -> Devices and Printers -> Print server properties tab as shown in 



figure below: 
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Steps Description  



2 Go to Start -> Control Panel ->Hardware and Sound -> Devices and Printers ->-> Print server properties tab-> Forms 



tab as shown in figure below: 
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Steps Description  



3 Go to Start -> Control Panel ->Hardware and Sound -> Devices and Printers -> Select printer -> Right click -> Printing 



Preferences as shown in figure below: 
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Steps Description  
4 Go to Start -> Control Panel ->Hardware and Sound -> Devices and Printers -> Select printer -> Right click -> Printing 



Preferences -> Layout tab -> Advanced as shown in figure below: 
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Steps Description  



5 Go to Start -> Control Panel ->Hardware and Sound -> Devices and Printers -> Select printer -> Right click -> Printing 



Preferences -> Layout tab -> Advanced as shown in figure below: 
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Steps Description  



6 Go to Start -> Control Panel ->Hardware and Sound -> Devices and Printers -> Select printer -> Right click -> Printer 



Properties as shown in figure below: 



 



 
 



__________________________________________________________________________________ 



        
 



44 of 49 











 



  



 Finacle Desktop Configuration and IE Setting 



  Infosys® 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



Steps Description  



7 Go to Start -> Control Panel ->Hardware and Sound -> Devices and Printers -> Select printer -> Right click -> Printer 



Properties -> Device Settings as shown in figure below: 
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Steps Description  



8 Go to Start -> Control Panel ->Hardware and Sound -> Devices and Printers -> Select printer -> Right click -> 



Printer Properties -> Device Settings as shown in figure below: 



 



 
 



Steps Description  



9 Go to Start -> Control Panel ->Hardware and Sound -> Devices and Printers -> Select printer -> Right click -> 



Printer Properties -> General Tab-> PassbookNew1 as shown in figure below: 
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Steps Description  



10 Go to Start -> Control Panel ->Hardware and Sound -> Devices and Printers -> Select printer -> Right click -> 



Printer Properties -> General Tab-> PassbookNew1 as shown in figure below: 



 



 
 



Steps Description  



11 Go to Start -> Control Panel ->Hardware and Sound -> Devices and Printers -> Select printer -> Right click -> Printer 



Properties -> General Tab-> PassbookNew1-> Page Setup -> change font as shown in figure below: 
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  5. Settings for Signature enquiry through SVS 



   



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



 



Steps Description  



1 Go to Start .In run type Java Control Panel and Enter .open Java Control Panel as shown in figure below: 



 



 
 



Steps Description  



2 Click on view button, and check the ‘Enabled’ check the box for both User and System as shown in 



figure below: 
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  6. Procedure to Import Registry key 



   



  PFA the registry key. 
   



   
IE_settings_new.zip



 
 
 



1. Press the Windows + R keys to open the Run dialog, type regedit, and press Enter. 



2. In regedit, File > Import > (select attached file). 
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1. When the instruments are lodged and verified in HICTM, please invoke HMICZ to Suspend the zone and then select Validation Run 



2. The below report is shown when the duplicate instrument has been lodged. 



[image: ]





3. In such cases , one of the record has to be marked as Inward Reject 



4. Invoke HMICZ , select function as 'Revoke Suspension' and enter the zone code



5. In HICTM menu, select modify function and click on Go. 



[image: ]

6. Next screen click on Accept

[image: ]



7. If the Carve Flag is defaulted as Yes, please select it as No first and then 

8. Mark the listed instruments as Inward Reject. Select the Reject* as Inward.  Then click on the Explode button beside it.

[image: ]



9. The below screen comes up. Enter the Reject reason code and then click on the Charges button below appearing near Accept 



[image: ]



10. Make the charge amount as zero as the customer shouldn’t be charged due to instrument listed twice .



[image: ]



11. Enter the waive reason code and then click on Accept.

[image: ][image: ]

12. Again click on Accept here.

[image: ]

13. Click on the explode button for the Additional details and enter the Presenting bank sort code.

[image: ]
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14. Once all the details are entered, click on Submit.

[image: ]



15. Click on Submit and verify through another user.

16. Invoke HMICZ and suspend the zone.

17. Invoke HMICZ and run 'Validation run' and 'Validation report'

18. Invoke HMICZ and Post the zone

19. [bookmark: _GoBack]Invoke HMICZ and close the zone
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